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About this Workbook

This workbook is designed to be used in conjunction with the Integrating Arm Cortex-M
processors in Xilinx FPGAs course.

The contents of this workbook are created by Adiuvo Engineering & Training, Ltd.

If you have any gquestions about the contents, or need assistance, please contact Adam
Taylor at adam@adiuvoengineering.com.
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Pre-Lab

Workshop Pre-requisites



Required Hardware

The hands-on labs in this course use the following hardware:

Digilent Arty S7-50 development board
Digilent PmodNAV

Digilent PmodHYGRO

USB-A to Micro-B cable



Downloads and Installations

Step 1 — Download and install the following at least 1 day prior to the workshop. This may take a

significant amount of time and drive space.

Vivado 2018.2 Download
**Please check that it is this version and not a

newer version**

Digilent Board Files Download
Arm Design Start FPGA IP Download
*Download Cortex-M1 for Xilinx**

Arm Keil MDK Tools Download
Arm Keil Licensing Tool Download
Digilent Vivado IP — Master Branch Download
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https://www.xilinx.com/support/download/index.html/content/xilinx/en/downloadNav/vivado-design-tools/archive.html
https://github.com/Xilinx/XilinxBoardStore/tree/2018.2
https://www.arm.com/resources/designstart/designstart-fpga
https://www.keil.com/download/product/
http://digilentinc.com/arty-s7-workshop-mdk-add-on
https://github.com/Digilent/vivado-library/tree/master/ip

Lab 1

Exploring the Architecture in Vivado



Lab 1: Exploring the Architecture in Vivado

Step 1 - Ensure you have the following environment path variables set:

Edit environment variable X

C:\Keil _v5\ARM\ARMCC\bin
%SystemRoot% o~ New
%SystemRoot%\System32\Wbem

C: \X| lin X\VI vado \20 18 2\b in %SYSTEMROOT%\System32\WindowsPowerShell\v1.0\ Edit

’ ’ C\Users\aptay\AppData\Local\Programs\Python\Python36-32

C:\Aldec\Riviera-PRO-2016.10-x64\bin Browse..
C\Xilinx\Vivado\2016.2\bin
C:\Python27\python.exe Delete

C:\Program Files\PuTTY\
C:\Program Files\Git\cmd
CA\Aldec\Riviera-PRO-2017.02-x64\bin

) ) ) Move Up
C:\Program Files (x86)\Pico Technology\PicoScope6\
C:\Program Files (x86)\IVI Foundation\VISA\WinNT\Bin\

) ) ) ) Move Dawn
C:\Program Files\IVI Foundation\VISA\Win64\Bin\
C:\Program Files (x86)\IVI Foundation\VISA\WinNT\Bin
%SYSTEMROOT%\System32\OpenSSH\

: Edit text...

il ket

CAXilin\Vivado\2018.2\bin

T T iy
C\Keil_v5\ARM\ARMCC\bin

ThmaeneoIpLvagrancom
C:\Program Files\TortoiseSVN\bin

Copyright 2020 Adiuvo Engineering & Training, Ltd. 8



Step 2 — Navigate to the directory containing the downloaded Arm M1 Core. This will be called
AT472-BU-98000-rOp1-00rel0.tgz.

Lab 1: Exploring the Architecture in Vivado

Step 3 — Using a compression program (e.g., seven zip) unzip everything, including the inner
directory.

» O5(C) » ARM_ESC

L5
-l
[ k]

Name Date modified ype

| AT472-BU-58000-r0p1-00rel0.tgz 18/04/2019 13:30 TGZ File 6,699 KB



Lab 1: Exploring the Architecture in Vivado

Step 4 — When extracted you should see the directory structure below.

> ARM_ESC > AT472-BU-98000-rOp1-00rel0 > AT472-BU-98000-rOp1-00rel0 > AT472-BU-98000-r0p1-00rel0

P

]

Name Date modified Type Size

docs 18/01/2019 11:41 File folder

hardware 18/01/2019 11:41 File folder

software 18/01/2019 11:41 File folder

vivado 18/01/2019 11:41 File folder
w Arm_Cortex-M1_DesignStart_FPGA_Xilinx...  17/01/2019 15:30 Adobe Acrobat D... 494 kB
i;,' THIRD-PARTY_SW.txt 10/12/2018 12:23 TXT File 3 KB

Copyright 2020 Adiuvo Engineering & Training, Ltd. 10



Step 5 - If you have not installed the Digilent Board files already, copy the Digilent boards contained in
the directory below into <Vivado Install path>\Vivado\2018.2\data\boards\board _files

Lab 1: Exploring the Architecture in Vivado

> KilinkBoardStore-2018.2.zip » XilinxBoardStore-2018.2 > boards > Digilent

N Name ) < Type Compressed size Password p..  Size Ratio Date modified
arty File folder 13/12/2018 20:55
arty-a7-35 File folder 13/12/2018 20:55
arty-a7-100 File folder 13/12/2018 20:55
arty-s7-25 File folder 13/12/2018 20:55
arty-s7-50 File folder 13/12/2018 20:55
arty-z/-10 File folder 13/12/2018 20:55
arty-z7-20 File folder 13/12/2018 20:55
basys3 File folder 13/12/2018 20:55
cmod_a/-15t File folder 13/12/2018 20:55
cmod_a7-35t File folder 13/12/2018 20:55
cmod-s7-25 File folder 13/12/2018 20:55
cora-z7-07s File folder 13/12/2018 20:55

T | Cile Fuldmw AF AN OO0 INLECC



Lab 1: Exploring the Architecture in Vivado

Step 6 — Open Vivado 2018.2. If you are familiar with Vivado do _not do this by opening the project file.

ile  Flow Tools Window  Hel

Step 7 — Change the VIVADO! £ XILINX

directory using the TCL
console to: Quick Start

cd C:\\<YOUR

DIRECTORY>\\AT472- Tasks
BU-98000-rOp1-00rel0 o N\

Copyright 2020 Adiuvo Engineering & Training, Ltd. 12



Lab 1: Exploring the Architecture in Vivado

Step 8 — In the TCL Console enter the following command exec subst V: .
Make sure there is a space between “:” and “ . ”

This gets around the character limit on file paths in Windows by mapping the PWD to the V directory.
Using a file browser to explore the V directory should show this file structure:

OS (V)
Name Date modified Type Size
docs 18/01,/2019 11:41 File folder
hardware 18/01/2019 11:41 File folder
software 18/01/2019 11:41 File folder
vivado 18/01/2019 11:41 File folder
= Arm_Cortex-M1_DesignStart_FPGA_Xilirk...  17/01/2019 15:30 Adobe Acrobat D... 494 KB

I’ THIRD-PARTY_SW.txt 10/12/2018 12:23 TXT File 3 KB



Step 9 — The next thing we need to do is map in the IP repository. In Vivado click on Tools = Settings

Lab 1: Exploring the Architecture in Vivado

¢ Vivado 2018.2

File Flow Tools Window Help D Quick Access

Run Tcl Script...

V I \# Compile Simulation Libraries...
H

Xilinx Tcl Store...

Custom Commands »

Q Language Templates

| £ Settings...

QUIU\ kel

Create Project >

Open Project >

Copyright 2020 Adiuvo Engineering & Training, Ltd. 14



Lab 1: Exploring the Architecture in Vivado

Step 10 - In the dialog box select IP Defaults.

¢ Settings X
IP Defaults
Tool Settings Specify default IP example directory and IP repository search paths '

Project

IP Defaults Default IP Example Project Directory

Source File

Display ® Last projects directory

WebTalk Specify project directory

Help

Text Editor IP Catalog

3rd Party Simulators

Colors Default IP Repository Search Paths
Selection Rules -+
Shortcuts

Strategies

Window Behavior

© Note: Default IP repository search paths will be applied only at new
project creation

(? OK Cancel Apply Restore..




Step 11 — Select the Add IP /' Settings x
repository button (shown as a +).

Lab 1: Exploring the Architecture in Vivado

IP Defaults
Tool settjl]gs SDQCI“ default IP example direc‘.‘tory and IP repositor\,‘ search paths. '
Project
N aV| g ate to g DEfa“'_‘s Default IP Example Project Directory
Source File
- - . - i i ]
V:\Vivado\Arm_IPI_Repository s e
—_— —_— WebTalk Specify project directory:
Help
> Text Editor IP Catalog

3rd Party Simulators

5 Colors Default IP Repository Search Paths

Selection Rules +
Shortcuts

V-Nivado/Arm_ipi_repository
> Strategies

> Window Behavior

© Note: Default IP repository search paths will be applied only at new
project creation.

2 Ok Cancel I [ Apply Restore...

Copyright 2020 Adiuvo Engineering & Training, Ltd. 16



Lab 1: Exploring the Architecture in Vivado

Step 12 — We are now ready to open the project. Select File=>Project-=>Open.

Navigate to V:/hardware/m1 for_arty s7/m1 for_arty s7
Select the project file m1_for_arty s7.xpr

¢ Open Project X
Look jn: m1_for_ary_s7 v toLldEr, @B XC =
»  mA_for_arty_s7.xpr Recent Directories
~

File name: mA_for_arty_s7 xpr

Files of type Vivado, PlanAhead, and ISE Project Files (.xpr, ppr, xise)

V.hardware/m1_for_arty_s7

File Preview
File: m1_for_arty_s7 xpr
Directory: V:hardware/m1_for_arty_s7/m1_for_arty_s7
Created: Today at 12:07 PM
Accessed: Today at 12:07 PM
Modified: Thursday 13.12.18 03:15 PM
Size: 19 KB
Type: Vivado project
Version: Vivado v2018.2
Owner: DESKTOP-HQKVQ13\aptay




Lab 1: Exploring the Architecture in Vivado

Step 13 — If you see a critical message
about simulation do not worry. Click on SeuIcos > O 31 X
Continue / OK.

To open the block diagram, select on
the > arrow next to the top level.

@® cmsdk_uart_capture (cms

> Memory Initialization Files
> Constraints (.
> Simulation Sources

< b

Hierarchy |P Sources Libraries Compile Order

Copyright 2020 Adiuvo Engineering & Training, Ltd. 18



Lab 1: Exploring the Architecture in Vivado

Step 14 — Double click on the
highlighted file. This will open the block
diagram.

Sources

M4
I
+

Design Sources (4

@® cmsdk_uart_capture (cmsdk_uart_capture .y

> Memory Initialization Files (1

> Constraints (2
> Simulation Sources
4
Hierarchy |P Sources Libraries Compile Or

D

Copyright 2020 Adiuvo Engineering & Training, Ltd.
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Lab 1: Exploring the Architecture in Vivado

Step 15 - If you want to pop out and explore the block diagram click on the button highlighted below.

You can examine the settings of the IP cores by double clicking on them, however, do not change anything.

¢ m1_for_arty_s7 - [Vi/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_tor_arty_s7.xpr] - Vivado 2018.2 - o b

Eile  Edit Flow Tools Repgrts Window Layout Miew  Help Ready
=, =] X & F », B & Z ¥ O 4 Default Layout -
Flow Navigator E R S BLOCK DESIGN - m1_for_arty_s7 5
~ PROJECT MANAGER :
5 s Design J 5 (m iy Diagram 5 ? O
£+ Settings - . e "
Q = 4 o | g 1 X 9 QqQ e | 4 E & C 9 1 0
Add Sources
mA_for_arty_s7 - TE =)
— — S
Language Tempiates External Interfaces —— .:‘._
T P Catalog Interface Connections | - =
] — T
— 3 B
Ports " i m == —
~ IPINTEGRATOR Nets G r m = » = =
Create Block Design @d_bram_ctrl_0 h T | B mXm
axi_gpio_0
Open Block Design
Generate Block Design Sow File P rite |l
m1_for_arty_s7.bd = ,_1' B | =] o 8-
v SIMULATION - bl — —— E’
Run Simulation b N -
+" Enabled = o
»»»»»»» ren - -
ALY T e 3
v RTL ANALYSIS ] = -
Ge I —o
» Open Elaborated Design
Tel C |
v SYNTHESIS
P Run Synthesis Q = < n & E @
to_pc
to_pe
ardw ml_ =,

¥ IMPLEMENTATION

# Run Implementation

~ PROGRAM AND DEBUG

L Generate Ritstraam

Copyright 2020 Adiuvo Engineering & Training, Ltd. 20



Step 16 — The next step is to set up the software environment launch SDK by selecting File=>Launch.

Lab 1: Exploring the Architecture in Vivado

This will open a dialog, set the dialog as below in the diagram.

¢ Launch SDK H

Launch software development tool.

Exported location: V.Isoftware hd

Workspace: V:isoftware/m1_for_arty_s7/sdk_workspace v

Copyright 2020 Adiuvo Engineering & Training, Ltd. 21



Lab 1: Exploring the Architecture in Vivado

Step 17 — If you see a warning click Yes, SDK will then open

sdk_workspace - C/C++ - m1_for_arty_s7_wrapper_hw_platform_0/system.hdf - Xilinx SDK

File Edit Navigate Search Project Run Xilinx Window Help
Inlhg [B8~& %O~ W DHABE V!

B%|Y = 0O

I%5 Project Explorer &2
~ (@ m1_for_arty_s7 wrapper_hw_platform_0
 system.hdf

4 Target Connections
(= Hardware Server
(= Linux TCF Agent
= QEMU TcfGdbClient

=

3 system.hdf &2

m1 for arty s7 wrapper hw_platform 0 Hardware Platform Specification

Design Information

Target FPGA Device: 7550
Part: xc7s50csga324-1
Created With: Vivado 2018.2
Created On:  Thu Sep 20 14:20:31 2018

Address Map for processor Cortex_M1_0
Cell Base Addr High Addr Slave I/

axi_gpio_1 0x40120000  Ox4012ffff S_AXI
daplink_if_0_axi_single_spi_0 0x40030000  0x4003ffff AXI_LITE

daplink_if_0_axi_xip_quad_s.. 0x40000000  Ox4000ffff AXI_LITE
daplink_if_0_axi_xip_guad_s.. 0x00000000 0x000fffff AXI_FULL
daplink_if_0_axi_gpio_0 0x40010000  Ox4001ffff S_AXI
axi_gpio_0 0x40110000  Ox40711ffff S_AXI
axi_uartlite_0 0x40100000  Ox4010ffff S_AXI
axi_bram_ctrl_0 0x60000000  0xGO001ffF S_AXI
daplink_if 0_axi_quad_spi 0  0x40020000  Ox4002ffff AXI_LITE
axi_quad_spi_0 0x40130000  Ox4073ffff AXI_LITE

IP blocks present in the design

Clocks_and_Resets_i_const_1 xlconstant 11
Aanlink if N NAPlink tn Arty shield N NAPLink tn Artv chisld 10
Overview

[£X Problems &2
0 items

Description Resource

Mem/Reg
REGISTER
REGISTER
REGISTER
REGISTER
REGISTER
REGISTER
REGISTER
MEMORY
REGISTER
REGISTER

Path

7 = 8 [EsDKlog =

Loc

:44:03 INFO
:44:93 INFO
:44:095 INFO
:44:05 INFO

= 0 = outline % = 8

A
An outline is not available.

: XSCT server has started successfully.

: Successfully done setting XSCT server connection channel
: Successfully done setting SDK workspace

: Restoring global repository preferences:

V:\vivado\Arm_sw_repository

:44:05 INFO
:44:05 INFO

: Processing command line option -hwspec V:/software/ml_for
o REEEX MYVIVADO is set to 'C:\Xilinx\Vivado\2017.4\patches

>

Copyright 2020 Adiuvo Engineering & Training, Ltd.
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Step 18 — We need to add in the SW IP so that we can build the SW application correctly.

Lab 1: Exploring the Architecture in Vivado

Select Xilinx>Repositories.

sdk_workspace - C/C++ - m1_for_arty_s7_wrapper_hw_platform_0/system.hdf - Xilinx SDK
File Edit Navigate Search Project Run  Xilink Window Help

v | - videv QO viw! B Generate linker script l
il Board Support Package Settings
[?5 Project Explorer 2 (= Repositories
v (&F m1_for_arty_s7_wrapper_hw_platform_( 2= Program FPGA —
& system.hdf 2 Dump/Restore Daﬂ;‘are Repos mrﬂ‘.ﬁ{ references iP
Bl Program Flash ation
Launch Shell :evice: 7550
@ X5CT Console Part: xc7s50c
2 Create Boot Image ) - With:  Vivado :

Created On: Thu Sep

Addeanns Allam Ffar memmmemme .

Copyright 2020 Adiuvo Engineering & Training, Ltd. 23



Lab 1: Exploring the Architecture in Vivado

Step 19 - In the resultant dialog
select the following directory:

V:\Vivado\Arm_SW repository
We are now ready to start using

our Arm Cortex-M1 system, this
completes Lab 1!

|
type filter text

General
| C/C++
Help
Install/Update
Remate Developmen
Remaote Systems
Run/Debug
Team
Terminal
Tracing
~ Xilinx SDK
Boot Image
BSP Preferences
Flash Programminc
Hardware Specifici
Log Information Le
Repositories
SDK Capabilities
Toolchain Preferen

@

p

Add, remove or change the order of SDK's software repositories.

Local Repositories (available to the current wg

Global Repositories (available across workspai

V\vivado\Arm_sw_repository

SDK Installation Repositaries

C/Xilinx/SDK/2018.2/data/embeddedsw

Rescan Repositories

Note: Local repository settings take precedend

Browse For Folder

s

Choose a repository directory. A repository directory typically contains the 'drivers', 'bsp’ or 'sw_services' sub-directories.

i
-~
-~

-~

v W This PC
» 3D Objects
m Desktop
< Documents
& Downloads
J Music
= Pictures
B Videos
L0 0sS(C)

My Passport (D:)
Local Disk (L)
Os (V)
Xil
docs
hardware
precompiled_sim_libs
software
vivado
Arm_ipi_repository
v Arm_sw_repository
CortexM

=y Adam (\WDMYCLOUD) (Z:)
Libraries
- My Passport (D)

Folder:

Arm_sw_repository

Make New Folder

Copyright 2020 Adiuvo Engineering & Training, Ltd.
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Lab 2
Saying Hello World



Lab 2: Saying Hello World

Step 1 — Wait for Vivado to complete the bitstream generation.

m1_for_arty_s7 - [Vi/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7xpr] - Vivado 20182

File Eat Flow Tools
= B

4

v PROJECT MANAGER
£ Settings
Add Sources
Language Templates

& IP Catalog

IP INTEGRATOR

Create Block Design
Open Block Design

Generate Block Design

SIMULATION

Run Simulation

RTL ANALYSIS

> Open Elaborated Design

Window Layout View

X ® 5 » B 8 I

Flow Navigator E3 B BLOCK DESIGN - m1_for_arty_s7

Design
Q=3

m1_for_arty_s7

External Interfaces

Interface Connections

Ports

Nets

aa_bram_ctri_0

axi_gpio_0

Source File Properties

write_bitstream Complete

Default Layout

Settings Edit

Projectname

Project location

Project Summary

m1_for_arty_s7

Vihardware/m1_for_arty_s7/m1_for_arty_s7

Product family Spartan-7

Project part A )csga

Top module name 1_for_ar rappe

Target language eril

Simulator language Mixed

Board Part

Display name Arty S7-50

Board part name digilentinc.com:arty-s7-50:part0:1.0
Connectors No connections

B i nath, L. Dlioxdiadallndt Adatabhoscdeibaacd Slos

Copyright 2020 Adiuvo Engineering & Training, Ltd.
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Lab 2: Saying Hello World

L. ¢ mil_for_arty s7 - [V:/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.xpr
Step 2 — Export the hardware definition select

File Edit Flow Tools Reports Window Layout View

| , & », B o 3

. Project
File=>Export->Export Hardware ~
Add Sources... LOCK DESIGN - m1_for_arty_s7
v Close Project
S0t 2§ Design S
Save Block Design As... Q - e
m1_for_arty_s7
Close Block Design
> External Interfaces
Interface Connections
> Ports
v > Nets
heckpoint
Chackont § axi_bram_ctrl_0
IP > P axi_gpio_0
Text Editor b
Source File Properties
~ Export » Export Hardware...
Launch SDK Export Block Design..
Export Bitstream File... |
v Export Simulation...
Exit

S Nnan Flaharated Nacinn

Copyright 2020 Adiuvo Engineering & Training, Ltd. 27



¢ Export Hardware x

Lab 2: Saying Hello World

Step 3 — This will create a pop up. Select the
export |Ocat|0n as V\SOftware Export hardware platform for software p

development tools.

You do not need to include the bit stream [ include bitstream

Export to: V.isoftware v

If you see the warning below click Yes.

Product family: Spartan-7

2324-1)
#
per
Evnnrt hardsara nlatfarm far o nfhaara

¢ Module Already Exported X

o An exported file for this module was found at this location. Do you want to overwrite it?

™ [ | cancel

nnnnnnnnnnnnnnnnnnnn

Copyright 2020 Adiuvo Engineering & Training, Ltd. 28



Lab 2: Saying Hello World

Step 4 — Next, we need to open XDSK. Select A 1 for arty,s7 - [V-Mhardware/m_for arty_s7/m1_for arty_s7/m1_for
File Edit Flow Tools Reports Window  Layout
File=>Launch SDK [ proect ® b R
n Add Sources... LOCK DESIGN - m1_fic
v Close Project
: Design
Q = A

Save Block Design As...
m1_for_arty_s7

Close Block Design
> External Interfa

Interface Conne

> Ports
v > Nets
Checkpoint 2 |
> axi_bram_ctrl_(
IP r D axi_gpio_0
Text Editor v

Source File Propertiet

v Export 4
Launch SDK
v Exit

Y Anam Clakharatad Masinn



Lab 2: Saying Hello World

Step 5 — In the pop up box, for the export location select the location we just exported the hardware
definition to (V:\Software) and select the workspace located at:

V:\software\m1l for_arty s7\sdk _workspace

¢ Launch SDK >

Launch software development tool.

Exported location: V.isoftware A

Workspace: V:Isoftware/m1_for_arty_s7/sdk_workspace v

Copyright 2020 Adiuvo Engineering & Training, Ltd. 30



Lab 2: Saying Hello World

Step 6 — Once SDK is opened, we will see the hardware definition imported into SDK. Note, the part
should show xc7S50. You will also see the address spaces for all of the added peripherals.

sdk workspace - C/C++ - m1_for_arty_s7_ wrapper_hw_platform_0/system.hdf - Xilinx SDK
File Edit Navigate Search Project Run Xilinx Window Help

m [B-&~H-O~ R DBP@E V! v
[t5 Project Explorer 2 =&|¥ =0 & system.hdf &% = g
~ (@ m1_for_arty s7_wrapper_hw_platform_0 g . -~
m1_for_arty s7_wrapper_hw_platform_0 Hardware Platform Specification
£ system.hdf
Design Information
Target FPGA Device: 7550
Part: xc7s50csga324-1 I
Created With: Vivado 2018.2
Created On: Thu Apr 18 13:49:25 2019
Address Map for processor CORTEXM1_AXI_0
Cell Base Addr High Addr Slave I/f Mem/Reg
axi_gpio_1 0x40120000  0wx4012ffff S_AXI REGISTER
daplink_if_0_axi_single_spi_0 0x40030000  0x4003ffff AXI_LITE REGISTER
daplink_if_0_axi_xip_quad_s.. 0x40000000  O0x4000ffff AXI_LITE REGISTER
daplink_if_0_axi_xip_quad_s.. 0x00000000  OxQOOfffff AXI_FULL REGISTER
daplink_if_0_axi_gpio_0 0x40010000  0x4001ffff S_AXI REGISTER
axi_gpio 0 0x40110000  Ox4011ffff S_AXI REGISTER
axi_uartlite 0 0x40100000  Ox4010ffff S AXI REGISTER
axi_bram_ctrl_0 0x60000000  Ox60001fff S_AXI MEMORY
daplink_if_0_axi_quad_spi_0  0x40020000  Ox4002ffff AXI_LITE REGISTER
axi_quad_spi_0 040130000  Ox4013ffff AXI_LITE REGISTER
IP blocks present in the design
Clocks_and_Resets_i_const_1 ¥lconstant 1.1
v

Aanlink if N NAPLink to Artu chisld 1

Overview

NAPLink tn Arty chield 10



Lab 2: Saying Hello World

Step 7 — The next step in SDK is to create a BSP, this will create APIs which enable us to work with the
peripherals included in the design. Select File>New->Board Support Package.

sdk_workspace - C/C++ - m1_for_arty_s7_wrapper_hw_platform_0/system.hdf - Xilinx SDK

File Edit Navigate Search Project Run Xilink Window Help

New Alt+Shift+N > & Application Project
Open File.. 1 SPM Project
Open Projects from File System... If: Board Support Package

™ Project..
Close Ctrl+W }}-
Close Al Ctrl+Shift+wy & Source Folder -
) 0 Folder
oave Crl+> & Source File
JaVE RS [\ HeaderFile
Paven Ctr+Shift+S 1+ File from Template 2
Revert @ Class 3.
Move... ™ Other... Ctrl+N
Rename.. F2 1

Addrace Man far nrareeenr CORTF



Lab 2: Saying Hello World

Step 8 — In the next dialog leave the name as the automatically generated one and click Finish.

MNew Board Support Package Project

Xilinx Board Support Package Project
:

Create a Board Support Package.

Project name: 5tandalone_b5p_0|

Use default location

Vi\software\m1_for_arty_s/\sdk workspace'standalone_bsp_0 Browse
default
Hardware Platform: m1_for_arty_s7_wrapper_hw_platform_0 ~ | New
CPU: CORTEXM1_AXI_D
32-bit
Standalone is a simple, low-level software layer. It provides access to basic processor
features such as caches, interrupts and exceptions as well as the basic features of a hosted

environment, such as standard input and output, profiling, abort and exit.

33
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Lab 2: Saying Hello World

Step 9 — This will open the BSP configuration page. Explore around and ensure the STDIN STDOUT is
set to the AXI UART. Once you have finished exploring click Finish and the BSP will be generated.

Board Support Package Settings

Board Support Package Settings

Control various settings of your Board Support Package.

Hardware Specification: V:\software\m1_for_arty_s7\sdk_workspace\m’_for_arty_s7_wrapper_hw_platform_0\system
CORTEXM1_AXI_O

Check the box next to the libraries you want included in your Board Support Package.You can configure the library

X

i

Standalone is a simple, low-level software layer. It provides access to basic
processor features such as caches, interrupts and exceptions as well as the basic
features of a hosted environment, such as standard input and output, profiling,
abort and exit.

Description

~ standalone_bsp_0
standalone
« drivers 0SType:  standalone
CORTEXM1_AXI_O i
0S Version:
Processor:
in the navigator on the left.
Name Version
@

Cancel

Board Support Package Settings

Board Support Package Settings

Control various settings of your Board Support Package.

~ Overview
standalane Configuration for OS: standalone
~ drivers Name Value
CORTEXM1_AXI_O hypervisor_guest false
lockstep_mode_debug false
sleep_timer none
stdin axi_uartlite_0
stdout axi_uartlite_0
ttc_select_cntr 2
zyngmp_fsbl_bsp false
false
false

Default
false
false
none
none
none

2

false
false
false

Type
boolean
boolean
peripheral
peripheral
peripheral
enum
boolean
boolean
boolean

e

Description

Enable hypervisor guest support for A53 64k
Enable debug logic in non-JTAG boot mode
This parameter is used to select specific time
stdin peripheral

stdout peripheral

Selects the counter to be used in the repectr
Disable or Enable Optimization for FSBL's BS
Enable MicroBlaze Exceptions

Enable S/W Intrusive Profiling on Hardware
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Lab 2: Saying Hello World

Step 10 — Once the BSP has finished generating you will notice a new MSS file opens in SDK, along

with a new project under the project explorer. This is the board support package. You can see the BSP
files and the APIs included in the design.

sdk workspace - C/C++ - standalone_bsp_0/system.mss - Xilinx SDK
File Edit Navigate Search Project Run Xiline Window Help

i |[®~&~i~0~- WD EBA@E /i GCro~

[t5 Project Explorer
v @ m

s7_wrapper_hw_platform_0
~ il standalone_bsp_0
i BSP Documentation
~ = CORTEXM1_AXI_0
(= code
(= include
& lib
~ = libsrc
(= bram_v4_2
(= cpu_cortexm1_v1_1
(= gpio_v4_3
= spivd 4
= standalone_v6_7
(= uartlite_v3_2
 Makefile
Hh system.mss

A&|Y Y= 0 i, system.mss &2 =8

standalone_bsp 0 Board Support Package ”

Madify this BSP's Settings | | Re-generate BSP Sources

Target Information

This Board Support Package is compiled to run on the following target.

Hardware Specification: V:\software\m1_for_arty_s7\sdk_workspace\m1_for_arty_s7_wrapper_hw_platform_0\system.hdf
Target Processor: CORTEXM1_AXI_0

Operating System

Board Support Package OS.
Name: standalone
Version: 6.7

Description: Standalone is a simple, low-level software layer. It provides access to basic processor features such as caches, interrupts and exceptions
as well as the basic features of a hosted environment, such as standard input and output, profiling, abort and exit.
Documentation: Mot found

Peripheral Drivers
Drivers present in the Board Support Package.
axi_bram_ctrl_0 bram  Documentation Import Examples
axi_gpio 0 gpio  Documentation Import Examples
axi_gpio_1 gpio  Documentation Import Examples
axi_quad_spi_0 spi Documentation Import Examples
axi_uartlite_0 vartlite Documentation Import Examples

daplink_if_0_axi_gpio_0 gpio  Documentation Import Examples
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Lab 2: Saying Hello World

Step 11 — Copy the files
Xpsuedo_asm_rvct.c

Xpseudo_asm_rvct.h

From V:\vivado\Arm_sw_repository\CortexM\bsp\standalone v6_7\src\arm\cortexml\armcc

Into V:\software\m1l for_arty s7\sdk workspace\standalone bsp O\CORTEXM1_AXI O\include



Lab 2: Saying Hello World

Step 12 — We now need to develop our SW application in Arm KEIL.
Navigate to V:/software/m1l for_arty s7/Build_Keil/. Click on the file m1_for_arty s7.uvprojx
This will open the Arm Keil project.

E Visoftware\m1_for_arty_s7\Build_Keil\m1_for_arty_s7.uvprajx - uVision - o X
File Edit View FProject Flash Debug Peripherals Tools SVCS Window Help

:Hﬁ'dﬂ\m BRI || PR R EE G ERe a-|e @¢-|-\-\|

@8 ﬁ- r—~a| ¥ m1_for_arty_s7 E ﬁ ﬁ =R ] 7 ﬂ
Froject L |
= “% Project: m1_for_arty s7

@@ m1_for_arty_sT

@ Cd CMsIS
(#-[d Standalone_v6_T
(3 Main
@1 GPIO
-0 sP
& 3 UART
@ 8 Xiline GPIO
@ L Xilinx SPI
@ 3 Xilinx UART
@ cvsis

|
Dev.. [@s. | OF. [0,

'Bulld Output

ULINKZ/ME Cortex Debugger CAP_NUM SCRL OVR R/W

Copyright 2020 Adiuvo Engineering & Training, Ltd. 37



Lab 2: Saying Hello World

Step 13 — Make sure the target is setto m1_for_arty s7.

Open the Main directory under the project, and double click on main.c.

This will open the file for editing.

Step 14 — Scroll down to line 149 and change the output string from
print ("Example design for Digilent S7 board\r\n");

to

print (“Adiuvo Tutorial Example design for Digilent S7 board\r\n");




Step 15 — Before we can click on Build, we need to check the name of the Arm Cortex processor
generated by SDK. Use a file explorer and navigate to

Lab 2: Saying Hello World

V:\software\ml for_arty s7\sdk workspace\standalone _bsp O

Ensure the folder is named CORTEX M1 0 and not CORTEXM1_AXI 0 or similar, if they are, correct
the naming to CORTEX M1 0.



Lab 2: Saying Hello World

Step 16— Click on Build and you should see the project compile and produce necessary output files.

KA vasoftwareym1_for_arty_s7\Build_Keilym1_for_arty_s7.uvprojx - pWision - [m] *

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help
. A a r E i = JR2e Qe

':" Q - ls‘l' m1_for_arty_s7 v f\ ﬁ 4 ‘“@

Project L0 = | ] main - X
% Project m1_for_arty_s7 139

&3 mi_for_arty_ 140

& [ Cmsis it

L Standalone_vE_7

N var };
# ] outbyte.c
%] print.c
wil_sssert.c
wl_printf.c
= Ld Main

d GPIO
il 5P

3 UART

3 Xilineg_GP1O
&l Xilinoe SPI
5 (3 il UART
& omss

of (bram_data)/
++ = bram data[i]:

&ev. (@6 | O
Build Output a @3

Vil

ULINKZ/ME Cortex Debugger L161 C:20 HLIM V|
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Lab 2: Saying Hello World

Step 17— Use a file browser to navigate to V:\hardware\m1 for_arty s7\m1 for_arty s7. You will see
a files named bram_s7.elf and bram_s7.hex (these should have today’s time stamp as you just
generated them).

OS (V:) > hardware > m1_for_arty s7 > m1_for_arty_s7

A Nate rnAified Tirne
NG < Ualc JU cu \ =

m1_for_arty_s7.cache 18/04 19 13:3 e folde
m1_for_arty_s7.hw
m1_for_arty_s7.runs
m1_for_arty_s7.sdk 18/04/2019 14:12
m1_for_arty_s7.sim
bram_s7.elf
bram_s7.hex
m1.mmi

¢ mi_for_arty s7.xpr 18/04/2019 14:02
m1_for_arty_s7_reference.bit
m1_for_arty_s7_reference.mcs 13/12/2018 15:15 MCS File
make_mmi_file.tcl
make_prog_files.bat

make_prog_files.tcl



Lab 2: Saying Hello World

Step 18 — Double click on the make_prog_files.bat this will create the bit file needed with the Cortex-
M1 and application we just created to download into the Arty S7-50 board.

Step 19 - In Vivado open Hardware Manager:

¢ m1_for_arty s7 - [Vi/hardware/m1_for_arty n1_for_arty s7/m1_for_; $7xpr] - Vivado 20182

Eile Edit Flow Jools Repgrts Window Lajout View Help

= o X
write_bitstream Complete

Default Layout v

Project Summary

m1_for_arty_s7
V/hardware/m1_for_arty_s7/m1_for_arty_s7

Spartan-7

Arty S7-50
digilentinc. com:arty-s7-50:part0:1.0
No connections

- o018 2idatalhaadel sl

1~ & & »r B & X ¢ ¢
Flow Navigator BLOCK DESIGN - m1_for_arty_s7
Design
Language Templates Q = A -3
Settings
T IP Catalog m1_for_arty_s7
External Interfaces Project name:
v IP INTEGRATOR Interface Connections Project location
Create Block Design Ports Froduc fanly
Nets Project part
Open Block Design
o an_bram, Top module name
Generate Block Design and_gp Target language:
Simulator language
v SIMULATION Source File Properties
Run Simulation o
Board Part
v RTLANALYSIS Display name:
> Open Elaborated Design Board part name:
Connectors.
v SYNTHESIS -
P Run Synthesis Tel Console
> Open Synthesized Design QT 2 n1'e E8

IMPLEMENTATION
P Run implementation

> Open Implemented Design

v PROGRAM AND DEBUG
¥ Generate

> Open Hardwar

Specity and/or create source files to add to the project
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Lab 2: Saying Hello World

Step 20 — Once Hardware Manager is open select Open Target and auto connect. This will open the
JTAG link with the target board.

¢ m1_for arty 7 - [V:/hardware/m1_for_arty s7/m1_for_arty s7/m1_for_arty s7xpr] - Vivado 20182

File Edit Flow Tools

=

Flow Navigator

Language Templates

& IP Catalog

v IPINTEGRATOR
Create Block Design

Generate Block Design

v SIMULATION

Run Simulation

v RTLANALYSIS

> Open Elaborated Design

v SYNTHESIS

P Run Synthesis

indow Layout  View Help

LD

£ B HARDWARE MANAGE

© No hardware targe

Hardware

S

Source File Properties

write_bitstream Complete



Lab 2: Saying Hello World

Step 21 — We are now connected to the Arty S7-50 board and can program it. Before we do this we

should open a terminal program, such as terra term or PuTTY, so we can see the output from the serial
link. Set it for 115200, 1 Start, 1 Stop no Parity.

Step 22 —To program the FPGA in Hardware Manager we need to select the correct bit file, select
Program Device.

4 m1_for_arty s7 - [V/hardware/m1_for_arty_s7/m1_for_arty s7/m1_for arty s7xpr] - Vivado 20182 - ] X
File Edt Flow Tools Reports  Window Layout  View Help write_bitstream Complete
& P,E B T Dashboard » Detault Layout

Flow Navigator EIL BN  HARDWARE MANAGER - localhosthilinx ictiDiilent/210352A8C168A

© There are no debug ol

Language Templates Hardware
T 1P Catalog Q = & o
Name Status
v IPINTEGRATOR ¥ localhost Connected
Create Block Design Mo xlinx_tctDigilent’21035246C1...  Open
pen Block D Fpm—
XADC
te Block D
v SIMULATION Properties
R Y &

Open Synthesized Design Tcl Console



Lab 2: Saying Hello World

Step 23 — When the dialog appears select the file

V./hardware/m1l for_arty s7/ml for_arty s7/ml for_arty s7.bit

¢ Program Device

programming file.

Bitstream file:

Debug probes file:

Select a bitstream programming file and download it to your hardware device. You can optionally
select a debug probes file that corresponds to the debug cores contained in the bitstream

V/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.bit

¥'| Enable end of startup check

==

/
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Lab 2: Saying Hello World

Step 24 — Check the output in your terminal, it should look similar to below:

EP COM26 - PuTTY — O P ‘

As we build on top of the existing reference design we can also press BTN1 and BTNO on the Arty S7-50
to see LDO and LD1 cycle through colors with each press.

This concludes Lab 2!



Lab 3

Completing a Simple Application



Lab 3: Completing a Simple Application

Step 1 - In Vivado we need to add in IP cores from the Digilent IP library. This requires that we first add
in the IP repository. To do this click on the Project Settings.

¢ mi_for_arty_s7 - [V:/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.xpr] - Vivado 2018.2

File Edit Flow Tools Reports Window Layout View Help
&) B e X o= » s@x ¥ €«
Flow Navigator F S BLOCK DESIGN - m1_for_arty_s7
v PROJECT MANAGER &
S : Design X S 15 O Diagra
£+ Settings
Q| =4 o @

Add Sources
m1_for_arty_s7

n Templat
ERpEOe TR, External Interfaces

LF IP Catalog > Interface Connections
Ports
v IP INTEGRATOR » '« Nets

Create Block Design axi_bram_ctrl_0

axi_gpio_0
Open Block Design i
Generate Block Design source File Properties Mor
m1_for_arty_s7.bd &
v SIMULATION
Run Simulation 7/ Enabled
| Anatinn: \tharruaralmd far arke a7hiask dinaram
v RTLANALYSIS ; .
General Properties

> Open Elaborated Design
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Lab 3: Completing a Simple Application

Step 2 — This will open the project settings dialog box. Select IP->Repository and click on the + button
to add a IP repository.

# - Settings Y

IP > Repository
Project Settings Add directories to the list of repositories. You may then add additional IP to a selected '
repository. If an IP is disabled then a tool-tip will alert you to the reason

General
Simulation
Elaboration IP Repositories
Synthesis
+ -

Implementation
Bitstream v:Nivado/Arm_ipi_repository (Project)
P

Repository

Packager

Tool Settings
Project
IP Defaults

Refresh All

Source File

Display

WebTalk

Help

Text Editor

3rd Party Simulators
» Colors

Selection Rules

Shortcuts

Strategies

Window Behavior

? oK Cancel Restore




Lab 3: Completing a Simple Application

Step 3 — Navigate to the location of the Digilent IP library on your system (downloaded during the Pre-
Lab). If you do not have them they can be downloaded from https://github.com/Digilent/vivado-library.

Step 4 — When you see the dialog below click OK.

¢ Add Repository *

1 repository was added to the project. For more information related to
disabled IPs, please refer to IP Catalog.

Repository

-

= v cihdl_projects/digilent
> IPs (61

4

» Interfaces
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Lab 3: Completing a Simple Application

Step 5 — We are now able to begin adding in the IP from this library into our Vivado design. The first

stage is to close the IP settings and open the block diagram. Float the block diagram so we can make
it fit the screen by selecting the button highlighted below.

o
E Tools Layout Yie H wite_| am Comp v
- e X &« F p 8 & X 3.6 & Defaur Layou v
v PROJECT MANAGER
Design Diagram
$ Semngs
Q = = o/ aaixoa s + @ * C
m1_foe_acty_s7 B = e
Extenal Intectaces | - =——1%
- T 3 1
rtertace Connections ” ~ » 3
Pon o 3 E ] 2 LE 2323 =
¥ P INTEGRATOR Nets i "
A cam_c [_ L !
peo_0 s
i
Source File Propertie: ‘;
m1 rty_s7.00 L+ — |
| =] pm————3
Gen
0

spdate 1




Lab 3: Completing a Simple Application

Step 6 — We are now going to add in the Pmod Nav and Pmod HYGRO. In the block diagram select
the + button. This will bring up a dialog which we can use to add in the necessary IP.

[

T

|

axi_beam e

(o1)
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Lab 3: Completing a Simple Application

Step 7 — To add Pmod Nav, in the search bar type
“pmodnav” and double click on the IP to add it into
the block diagram.

Step 8 — To add in the Pmod HYGRO, repeat steps
6-7 by clicking the + button again and in the search
bar type “pmodhygro” double click on the IP to
add it into the block diagram.

____________

oooooooooooooo

ST

a
2
o)
&
T =
sh3883




Lab 3: Completing a Simple Application

Step 9 — Check that both the IP blocks have now been added in the block diagram.

Diagram
a a iE ol a s + ¥ * Cl g o o

» Designer Assistance avallable. Run Connection Automation

w_oe
e e =
| | dien 4
i g 4 — O
D ! b . [ A 8 50
L] e loaxe - WL
= D> v 2| o e bt 55l [
I e ke e | ety .
- srnese ves - e - -
e Phoinypisad NI | ool - _— P E—
- e g
e v 4 weone b 1 pe gramliipes ¢ — ] i —
[s=—arm =t oa 2 f= I
o e e . | ; 3 — - s —1
Je \ s
a0 B2
+

i
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Lab 3: Completing a Simple Application

Step 10 — Click on the Run Connection Automation option. This will open a dialog to connect in the

newly added IP.

Diagram

_—
o -
== | ;
p— |
R — i
L |
[E— -
e b —] — o | |
. D | P e —— | ORTEM!_AX +
- i d !
R
° Rl —
e - —r
- BOESTANTD 4. - |
- 2T Or o } o ||
m =i s 1 1
t R g ]
o e esad o —-—
[| 3= | “ r—"
]
I— | w5 0
—————e e e

- - | D o
r—q - ¢ - ]
!
TS e B — ; B
—
e
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Lab 3: Completing a Simple Application

Step 11 - In the dialog check All Automation and click OK.

¢ Run Connection Automation *

Automnatically make connections in your design by checking the boxes of the interfaces to connect Select an interface on the left o display its configuration oplions on the
right

Al | &
L 7 a1 Automation (4 out of 4 selected) |
v | PmodHYGRO_D
/1 1 AXI_LITE_IIC Options
7|1} AXI_LITE_THR
+ ¥ PmodNAV_0
/|4 AXI_LITE_GPID
/1 ha_LmE_sPi Bridge P

Description

Connect Slave interface (iPmodMAV_0/AXI_LITE_SPI) 1o a selected Master address space

Master
Clock source for driving Interconnect IP

Clock source for Master interface

Clock source for Slave interface Auto v
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Lab 3: Completing a Simple Application

Step 12 - You will see the updated block diagram with the PmodNAV and PmodHYGRO connected
into the AXI system and with the Cortex-M1 processor.

D
(=2
M
=
-
S L1
-
— C I = I—XI
=2 — — ’_‘: .y. —]
] e =a
. I ]~ = —
— =
J U+
u| = }
= arm =
4 -
1 —
p— 1 T
| I —] +[ D
—1 R : D o
] —
orcat 1 —
— -—
i D =
S r—
O
= JEN
— L
T I —
——
— u— r—
T I— T
g s
] ME—
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Lab 3: Completing a Simple Application

Step 12 (cont’d) — Make sure you connect the ext_spi_clk to the s_axi_clk

PmodNAV 0

{4 AXI_LITE_SPI
|4 AXI_LUITE_GPIO  Pmod_out = ||
— ext_spi_clk GPIO_Interrupt —

- 5 _axi_aclk SPI_Interrupt =
l—o s _axi_aresetn

PmodNAY v1 0O

Copyright 2020 Adiuvo Engineering & Training, Ltd. 58



Lab 3: Completing a Simple Application

Step 13 — At this point we have not added any 10 to these IP blocks connecting them to the Pmod ports

on the Arty S7-50.

The next thing to do is select the Connector JB under the board tab and drag and drop it on the

PmodHYGRO.

File Edit Flow Tools

= b «

v PROJECT MANAGER
£ Settings
Add Sources
Language Templates

&F IP Catalog

<

IP INTEGRATOR
Creale Block Design
Open Block Design

Generate Block Design

<

SIMULATION

Run Simulation

<

RTL ANALYSIS

> Open Elaborated Design

<

SYNTHESIS
P Run Synthesis

>

<

IMPLEMENTATION
» Run Implementation

>

<

PROGRAM AND DEBUG

15§ Genarata Ritstraam

Repaits

¢ mi_for_arty_s7 - [Vi/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.xpr] - Vivado 2018.2

Window  Layout View  Help

o

Ready

® @ r M & ¥ X ¥ € € Default Layout

Flow Navigator H BLOCK DESIGN - m1_for_arty_s7 *

@ 1P Catalog s out-of-date. Refresh IP Catalog

Board Diagram
Q = £ @ # a a X xE o Q s+ B # C o
12C i PmadHYGRO_0
e} 3
2C on J3 ”H'.D“ [ b AXLLITE TR
Pmod "TRST O] 2 AXILUITE i€ I
“# Connector JA Irit
0 Connector JB Auto connect board component
¥ Connector JC ‘Connector JB using interface pin
‘PmodHYGRO_0/Pmod_out’ 5
Board Com -
ponent Properties ——
o reset
) Connector JB - o 5_clock |—>_| PmodNAY_0 sys_cleck
T B
Description:  Pmod Connector JB roset | _i::l o e += -
exl s ok GPIO_Interrupt -,

General

Tcl Console

Q = £ Il B B @

automation -rule
YGRO_0/AXI_LITE_] is
automation 2 r
RO_0/AXT_LITE_IIC/Reg0>

c

mapped in

mapped into

12 462 331) cells PmodNAV_0]

Clocks_and Resets/clk_wi

cks_and_Resets/clk_wi
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Lab 3: Completing a Simple Application

Step 14 — This should show the connection to the PmodNAV correctly.

¢ Auto Connect et

o Board component ‘Connector JB" was connected to block 'PmodHYGRO_D".
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Lab 3: Completing a Simple Application

Step 15 — Repeat the same thing for PmodNAYV and Connector JA.

¢ m_for_arty_s7 - [V:/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.xpr] - Vivado 2018.2 - O X
File Edit Flow Tools Repors Window Layout View  Help Ready
= H « B ® & p B &K F X ¥ ¢ ¢ Default Layout v

—
Flow Navigator z BLOCK DESIGN - m1_for_arty_s7 * ?
v PROJECT MANAGER A
Sources | Des Signals  Board 200 Diagram > O LC
£} Settings
Q = £ = Q g 3 m O Q s + ¥ # C 9 & @
Add Sources
Language Templates 0Gon13 o D—
v = Pmod t of ecte nTRST [
O
* IP Catalog ) Connector JA
PmadNAV_0
1 Cannector JB i
v IPINTEGRATOR ¥) Connector JC + AXI_UITE_SPI
+ AXI_LITE_GPIO 1
Create Block Design % Connector JD g e Auto connect board component  cs_and_Resets
Open Block Design Reset (1 out of - o s sk PI_imernpt ‘Conneclor JA' using interface pin. ) o
pen Block Lesig 5_a0_wesan 'POdNAY_0Pmod out' | s weserion) (ol
———TYTYY : S o cpu
Generate Block Design Board Component Properties . v sys_dock DT ANAV_v [ oo . ) COR
sywresdreq
) gresetri00] jm—1, "
K> Connector JA - o reset [ reset oo ]| S Hex
v SIMULATION o 7|E!D L - SYSRESETn
perphers_ereseint{ 0] e 1RO(7:)
Run Simulation Description: Pmod Connector JA —— NMI
—H CFGITCMEN 10| (
DBGRESETn
v RTLANALYSIS | ﬂuuﬂk&rmr
. General  Properties q AR ’
> Open Elaborated Design
Tcl Console x Messag Reports esig S ?
Vv SYNTHESIS
> a q .
P Run Synthesis G x s Il B E @
5 ; A B =
¥ IMPLEMENTATION R
P Run Implementation -
5 0 € . Memory (MB): peak = 1449.12% ; gain = 13.285
< >
Vv PROGRAM AND DEBUG
Ifi Generate Ritstream Y

ey, ————— ey il
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Lab 3: Completing a Simple Application

Step 16 — Again, you will see a confirmation of the connection.

¢ Auto Connect >

o Board component ‘Connector JA' was connected to block PmodNAV_0'.
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Lab 3: Completing a Simple Application

Step 17 — We now check assigned memory addresses. Save and close the block diagram and double
check in the Address Editor that all of the Pmods are in the Ox4xxx_xxxx Range.

BLOCK DESIGN - m1_for_arty_s7*

@ 1P Catalog is out-of-date. Reash If

Board Diagram ‘ Address Editor
Q = & = » a g3 X o aQ o + 2 »la =
i NP D Cell Slave Interface  Base Name OffsetAddress Range High Address
,m T B oy PN . ¥ CORTEXM1_AXI_0
“* Connector JA r1r . : :... po— ITH v CM1_AXI3
* Connector JB Auto conned board compond axi_bram_ctrl_0 S_AXI Mem0 8K v 0x6000_lFFF
O T Connecior J& ushy inlerdagy axi_gpio_0 S_AXI Reg 64K ~ 0x4011_FFFF
PmodHYGRO 0/Pmod_out'
daplink_if_0/axi_gpio_0 S_AXI Reg 0x4001_0000 64K v 0x4001_FFFF
R R , 4 axi_gpio_1 S_AXI Reg 0x4012_0000 64K ~ 0x4012_FFFF
= - © | po- i | axi_quad_spi_0 AXI_LITE Reg 0x4013_0000 64K ~ O0x4013_FFEF
Description  Pmod Connector JB t B 1 ___ M ey daplink_if_0/axi_quad_spi_0 AXI_LITE Reg 0x4002_0000 64K ~ 0x4002_FFFF
- 1 daplink_if_O/axi_single_spi_0  AXI_LITE Reg 64K ~ 0x4003_FFFF
Genoral pert axi_uartlite_0 S_AXI Reg 64K v 0x4010_FFFF

daplink_if_0/axi_xi gemp™0 AXI_FULL MEMO
Jaxi_xip_quad_spi_0 AXI_LITE Reg

AXI_LITE_SPI Reg0
PmodNAV_0 AXI_LITE_GPIO  Reg0
PmodHYGRO_0 AXI_LITE_LTMR  Reg0

modHYGRO_0 AXI_LITE_IIC Reg0

OF_FFFF

Tel Console
QEFEF

64K
64K ~ 0x4004_FFEY
4K ~  0x4005_OFFF

64K ~ O0x44R0_FFFF

0x44A1_FEE
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Lab 3: Completing a Simple Application

Step 18 — We are now ready to build the design. Click on the validate button to prove we have no
errors or critical warnings in the design.

¢ mil_for_arty_s7 - [Vi/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.xpr] - Vivado 2018.2

Eile Edit Flow Tools Repors Window Layout View  Help

= - B X & > B & X ¥ C C

Flow Navigator C B BLOCK DESIGN - m1_for_arty_s7

v PROJECT MANAGER -
Sources

Q = & + o

m1_for_arty_s7_i: m1_for_arty_s7 (m1_for_arty_s7.bd) (7) ~
> @ m1_for_arty_s7 (m 5

£# Settings
Add Sources

Language Templates

LF IP Catalog m1_for_arty_s7_PmodHYGRO_0_0
m1_for_arty_s7_PmodNAV_0_0
¥ IPINTEGRATOR m1_for_arty_s7_auto_pc_10

Create Block Design m1_for_arty_s7_auto_pc_11

m1_for_arty_s7_auto_pc_12
Open Block Design
D 9 m1_for_arty_s7_auto_pc_13 (m1_f t 1 v
Generate Block Design < >
Hierarchy IP Sources Libraries Compile Order
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Lab 3: Completing a Simple Application

Step 19 - Click on the generate bit stream button.

¢ mil_for_arty_s7 - [Vi/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.xpr] - Vivado 2018.2

Eile Edit Flow Tools Reports Window Layout View Help

- - B xch,fr‘Z ¥ O <

Flow Navigator c 3 B S BLOCK DESIGN - m1_for_arty_s7
v PROJECT MANAGER N
Sources x S ?
£+ Settings
Q = £ + o

Add Sources
m1_for_arty_s7_i: m1_for_arty_s7 (m1_for_arty_s7.bd) (7) ~

Language Templates
guag P > @ mi_for_arty_s7

T IP Catalog mA1_for_arty_s7_PmodHYGRO_0_0
mA_for_arty_s7_PmodNAV_0_0 (m
~ IPINTEGRATOR m1_for_arty_s7_auto_pc_10 (m1

Create Block Design m1_for_arty_s7_auto_pc_11
m1_for_arty_s7_auto_pc_12

Open Block Design

P 9 m1_for_arty_s7_auto_pc_13 (m1 3 t v
Generate Block Design < >
Hierarchy |IP Sources Libraries Compile Order
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Lab 3: Completing a Simple Application

Step 20 — This may take a little while but once the bit stream is completed you will see the message
write_bitstream_complete in the upper right hand corner of Vivado.

# - mi_for_arty_s7 - [Viy/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty s7.apr] - Vivado 2018.2

File Edit Flow Tools Repois Window Layout \View Help write_bitstraam Complate 4

= 5] X & B >, B & I ¥ ¢ ¢ Dafaul Layou v

Flow Navigator 3L BN A B OCK DESIGN - m1_for_arty_s7

w PROJECT MANAGER
Sources : 7 O Diagram
£} Sattings
e -~ L Y - -~
Qs+ g |laaunoaqs s+ g #CY o
Add Sources S
Design Sources A E
Language Templates f =
a9 P « @5 mi_for_arty_sT_wrapper
T o L b
W IP Catalog . mA_for_amy_s7_i: m1_for_arty_s7(m1_for_arty_s7.bd -52
> @ m1_for_arty_s7 lzl‘
v IPINTEGRATOR '
Creale Block Design Hierarchy fies L
Open Block Design Properties L 1_.
Generate Block Design o
T
v SIMULATION L .
= )
Run Simulation
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Lab 3: Completing a Simple Application

Step 21 — Now we need to update the MMI file. To do this we
need to open the implemented design.

There is a script we need to run to generate this, available under:
V:\hardware\ml for_arty s7\ml1 for_arty s7

In the TCL console, change the working directory to the one
above using:

cd V:\\hardware\\m1 for_arty s7\\m1 for_arty s7
Then enter the command source make mmi_file.tcl
This will create the updated MMI file.

Note, if you see any warning when you open the implemented
design, click on OK.



Lab 3: Completing a Simple Application

Step 22 — Next, export the hardware definition. Select File=>Export=>Export Hardware.

¢ mil_for_arty_s7 - [V:/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.xpr

File Edit Flow Tools Repors Window Layout View

> & > W B 3

I Project > |
H Add Sources. LOCK DESIGN - m1_for_arty_s7
v Close Project
Design
Q| = | A

Save Block Design As...
m1_for_arty_s7

Close Block Design
External Interfaces

Interface Connections

Ports
v > Nets
et i axi_bram_ctrl_0
P » D axi_gpio_0
Text Editor >
Source File Properties
~ Export » Export Hardware...
Launch SDK Export Block Design..
Export Bitstream File.
v Exit Export Simulation...

S Nnan Flahnrated Necinn



Lab 3: Completing a Simple Application

Step 23 — In the pop up, set the export location as V:\software

¢ Export Hardware *

Export hardware platform for software
development tools. /

[] Include bitstream

Export to: V:Isoftware A
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Step 24 — In the pop up, set the A Export Hardware »
export location as V:\software.

Lab 3: Completing a Simple Application

Export hardware platform for software
development tools. [

If you see a warning asking if you
want to overwrite the existing file,
CIICk YeS . Export to: V.isoftware v

[ include bitstream

Product family: Sparan-7

a3i24-1)
’
per
Evnnart harmhaars nlatfarm far enfhaarn

¢ Module Already Exported =

o An exported file for this module was found at this location. Do you want to overwrite it?

&) F | cancel

nnnnnnnnnnnnnnnnnnnn

Copyright 2020 Adiuvo Engineering & Training, Ltd. 70



Lab 3: Completing a Simple Application

Step 25 — Next, we need to open XDSK. Select File=>Launch SDK.

¢ mi_for_arty_s7 - [Vi/hardware/m1_for_arty_s7/m1_for_arty_s7/m1_for
Eile Edit Flow Tools Reports Window  Layout

| A

Project
n Add Sources LOCK DESIGN - m1_fc
v Close Project
Design
Q = 4

Save Block Design As

m_for_arty_s7
Close Block Design
External Interfac

Interface Conng

Ports
~ > MNets
Checkpoint
axi_bram_ctri_(
P » B axi_gpio_0
Text Editor »
Source File Propertie:
w Export 4
Launch SDK
M Exit

= DL el L PR e



Lab 3: Completing a Simple Application

Step 26 — In the pop up box, for the export location, select the location we just exported the hardware
definition to (V:\Software).

Select the workspace located at V:\software\m1 for_arty s7\sdk_workspace.

Note: Use File Explorer to confirm there is only one exported hardware definition under V:\software.
If there is a HDF file for the Arty A7, please delete it.

¢ Launch SDK et

Launch software development tool.

Exported location: V.Isoftware v

Workspace: V-isoftware/m4_for_arty_s7/sdk_workspace v




Lab 3: Completing a Simple Application

Design Information

Step 27 — In SDK you will see the hardware

Created With: Vivado 2018.2

definition and BSP being updated from what
we used in Lab 2. Under the BSP delete the e ———

. Cell Base Addr High Addr Slave I/f Mem/Reg
d I re Cto ry C O rt eX m 1 o . daplink_if_0_axi_single_spi_0 0x40030000 Ox4003ffff AXI_LITE REGISTER
—_— daplink_if_0_axi_gpio_0 0x40010000 0x4001Fff S_AXI REGISTER

axi_gpio_0 0x40110000 Ox4011FfF S_AXI REGISTER

axi_bram_ctrl_0 0x60000000 060001 ffF S_AXI MEMORY

. .. . axi_quad_spi_0 0x40130000 0x4013FffF AXI_LITE REGISTER

In the hardware definition you will see the e N B ==
PmodHYGRO_0 Ox44a10000 Ox4dalffif  AXILITE_IC REGISTER

daplink_if_0_axi_xip_quad_s... 0x40000000 0x4000Ffff AXI_LITE REGISTER

P m O d H YG R O an d P m O d N AV- daplink_if_0_axi_xip_quad_s.. 0x00000000 Ox000fFFfff AXI_FULL REGISTER
PmodNAV_0 0x40050000  O0x40050fff  AXI_LITE_G... REGISTER

axi_uartlite_0 0x40100000 O0x4010ffff S_AXI REGISTER

PmodHYGRO_O 0x44a00000 Ox44a0ffff AXLUTET... REGISTER

daplink_if_0_axi_quad_spi_0  0x40020000 0x4002ffff AXI_LITE REGISTER

PmodNAV_0 0x40040000 0x4004ffff  AXI_LITE_SPI REGISTER

In the BSP MSS file you will also see the drivers have been Peripheral Drivers
Drivers present in the Board Support Package.

included with the BSP. PmodHYGRO_0 PmodHYGRO

PmodNAV_0 PmodNAV

axi_bram_ctrl_0 bram Documentation Import Examples

axi_gpio_0 gpio Documentation lmport Examples

axi_gpio_1 gpio Documentation Import Examples

axi_guad_spi_0 spi Documentation Import Examples

axi_uartlite_0 uvartlite Documentation Import Examples
daplink_if 0 axi_gpio_0 gpio Documentation Import Examples
daplink_if_0_axi_guad_spi_0 spi Documentation Import Examples
daplink_if_0_axi_single_spi_0 spi Documentation lmport Examples
daplink_if 0_axi_xip_quad_spi_0 spi Documentation lmport Examples
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Lab 3: Completing a Simple Application

Step 28 — Next, we need to copy the files
Xpsuedo_asm_rvct.c and Xpseudo_asm_rvct.h

From

V:\vivado\Arm_sw_repository\CortexM\bsp\standalone v6_ 7\src\arm\cortexml\armcc

to

V:\software\ml for_arty s7\sdk_workspace\standalone _bsp O\CORTEXM1_ AXI_O\include

Step 29 — Check the name of the Cortex-M processor generated by SDK. Use File Explorer and navigate to
V:\software\m1_for_arty_s7\sdk_workspace\standalone_bsp_0.

Ensure the folder is named CORTEX_M1_0 and not CORTEXM1_AXI_0 or similar, if so correct the naming to
CORTEX_M1_0.



Lab 3: Completing a Simple Application

Step 30 — Now, let’s develop our SW application in Arm KEIL.

Navigate to V:/software/m1 for_arty s7/Build_Keil/. Click on the file m1_for_arty s7.uvprojx.
This will open the Arm Keil project.

Make sure the target is setto m1 for_arty s7.

Visoftware\m1_for_arty_s7\Build_Keil\m1_for_arty_sT.uvprojx - pVision

ile Edit View Projet Flash Debug Peripherals Tools SVCS Window Help

NELP ¥ D@9 || pPran|EEEk @ ERs@-lecoa- @]y
——— or_arty_s7 MR AR e Y@

ULINK2/ME Cortex Debugger CAP NUM SCRL OVR R /W)|
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Lab 3: Completing a Simple Application

Step 31 — The next thing we need to do is ensure
the compiler directives are set correctly for both our
application and the drivers we will be using. To
open the options, click on the highlighted button.

Ensure Optimization is set to Level-1 (O-1), C99 and
GNU extensions are enabled, if you want you can also
select the optimization level.

L‘ Visoftware\m1_for_arty_s7\Build_Keil\m1_for_arty_s7.uvprojx - uVision
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

S A FiE

AN A I ¥ m1_for_arty_s7 é @ A_Q @

Project 1 8
% Project: m1_for_arty_s7
#a m1_for_arty_s7
+ L4 CMSIS
# [ Standalone_v6_7
# L4 Main
# 4 GPIO
L SPI
+ L3 UART
% (. Xilinx_GPIO
# L4 Xilinx_SPI
# (3 Xilinx_UART

Options for Target 'm1_for_arty_s7°
Device | Target | Output | Listing | User ~ C/C++ ]F\sm | Linker | Debug | Utiies |

Preprocessor Symbols

Define: \comgx_mw ARTY_CM1

Undefine: [

Language / Code Generation

I~ Execute-only Code [~ Strict ANSIC Wamings
Ept\m\zabon ‘LeveH (01) ﬂ I [~ Enum Container always int r

I~ Optimize for Time [ Plain Charis Signed
I~ Spit Load and Store Mutiple [~ Read-Only Posttion Independent ¥ C99 Mode
I One ELF Section per Function [ Read-Write Posttion Independent v GNU extensions

<nspecfied> ¥

Include ‘ Memsis\CMSIS\Include;..\cmsis\Device\Include .. \cmsis\Device\Include \ARTY_CM1;..\adk_works :l

Paths

Misc
Controls

Compiler |-c99 —gnu < ~cpu Cortex-M0 i -g <01 -apcs=interwork - ../cmsis/CMSIS/Include -1
control | /cmsis/Device/Include -| .. /cmsis/Device/Include/ARTY_CM1
string

ok || cance Defauits

Help
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Lab 3: Completing a Simple Application

Step 32 — To work with the PmodHYGRO and the PmodNAV we need to add in the source code.

To do this we right click on the project and select Manage Project Iltems.

U Vsoftware\m1_for_arty_s7\Build_Keil\m1_for_arty_s7.uvprojx - pVision

File Edit
L El
L5 &) & -
Project

LifD
&"4 mi_for_arty s7 hd ,ﬁ.\ ﬁ
a B3

T Project m1_for_arty_s7

= g m‘]_for_:ﬂ-u e7

¥

2 R R = R R = O 3 [ - [ [ =

@i

—

Ll

—

L

|

M| AN

Xilir [

Options for Target ‘'m1_for_arty_s7"... Alt=F7

Add Group...

Manage Project ltems...

Open Map File

Open Build Log

Rebuild all target files

Build Target F7

Show Include File Dependencies

View Project Flash Debug Peripherals Tools 5SVCS Wind

@

Xilir—=
CMSIS



Lab 3: Completing a Simple Application

Step 33 — Under Groups we can add in the
PModHYGRO and the PModNAV as new
groups.

Then add in the source code which can be
found under the PmodXXXX drivers directory.

Find the drivers under:

V:\software\ml for_arty s7\sdk_workspace\
standalone _bsp O\CORTEX_ M1 O\Mibsrc

For the PmodNAYV do not include the SPI
source files. These are already included under
the Xilinx_SPI group

Manage Project ltems x
Project tems | Folders/Extensions | Books |
Project Targets: i} X | 4 | ¥ | Groups: X 4 ¥ Fies: X+ ¥
m1 for arty s7 CMSIS PmodHYGRO ¢

Standalone_v6_7 xilc.c

Main wilc_dyn_master.c

GPIO xiic_intr.c

SPI xiic_l.c

UART wilc_master.c

Xilinx_GPIO xilc_multi_master.c

Xilirx_SPI xilc_options.c

Xilinx UART xiic_sefftest.c

Xilinx_PmodHYGRO xiic_slave.c
xiic_stats.c
xtmrctr.c
xtmrctr_intr.c
stmrctr_|.c
xtmrctr_options.c
xtmrctr_sinit.c
xtmrctr_stats c

Set as Cumrent Target | Add Files.. |
OK | Cancel Help
78
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Lab 3: Completing a Simple Application

Step 34 — Open the PmodNAV.c and comment out usleep() calls.

Open xtmrctr_sinit.c under the Xilinx PmodHYGRO and edit the line to be XTmrCtr_Config
XTmrCtr_ConfigTable[1];

_] main.c ] xiicle ] wvartc | printc | xil_printf.c ] xtmrctr_sinit.c
58 L: jefine XPAR XTMRCTR NUM INSTANCES
59 = dif

60

6] --------------------------- =9 ak = = Sy ot KRR R R R R R R R R R R R R R R R R R R R R R R R R
VAL LAQLAT = ilalalbllllo

64.

63 [ A table of configuration structures containing the configuration information
64 L for each timer core in the system.

- - _ . . ) .
65 TmrCtr Confi XTmrCcr ConfigTable -
\ oI 1]:
6"? ............................ Tlraws =t 9 = v =T a e e RR R RO R R R R R R R R R R R R R R R R R R R R R R J
J o Midlw A 'Jad — ke e\ ad D
-
6..4-
-
GG R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R f
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Lab 3: Completing a Simple Application

Step 35 — We can then use the Pmods and create applications. In this example, let’s create a simple
application which reads the Pmods and Temperature, Humidity, X,Y & Z information over the terminal
by adding the following into our code in main.c:

#include "PmodHYGRO.h"

#include "PmodNAV.h"

#define TIMER_FREQ_HZ 100000000
PmodHYGRO myDevice;

PmodNAV nav;

bool sample;

float temp_degc, hum_perrh, temp_degf;

The above should be declared as global variables



Lab 3: Completing a Simple Application

Step 36 — To provide a timing reference you might want to use the system tick. This can be

accessed by

#define STCTRL  (*( ( volatile unsigned long *) OXEOOOEO010 ))
#define STRELOAD (*( ( volatile unsigned long *) OXEOOOEOQ14 ))
#define STCURR  (*( ( volatile unsigned long *) OXEOOOEQ18 ))
#define SBIT_ENABLE O

#define SBIT_TICKINT 1

#define SBIT_CLKSOURCE 2

#define RELOAD_VALUE 98999999

The ISR can be accessed using

void SysTick Handler(void)

{
sample=TRUE;

}

This is already mapped into the vector. Check out startup_arty _cml.s.

Copyright 2020 Adiuvo Engineering & Training, Ltd.

81



Lab 3: Completing a Simple Application

Step 37 — In the main loop add in the following code

HYGRO_begin(&myDevice,XPAR_PMODHYGRO _0_AX|_LITE_IIC_BASEADDR,0x40,XPAR_PMODHYGRO 0 AXI
_LITE_TMR_BASEADDR,1,TIMER_FREQ_HZ);

NAV_begin
(&nav,XPAR_PMODNAV_0_AXI_LITE_GPIO_BASEADDR,XPAR_PMODNAV_0_AXI_LITE_SPI_BASEADDR);
NAV_Init(&nav);

STRELOAD = RELOAD_VALUE;

STCTRL = (1<<SBIT_ENABLE) | (1<<SBIT_TICKINT) | (1<<SBIT_CLKSOURCE);

while (1)
{
if (sample == TRUE){
temp_degc = HYGRO_getTemperature(&myDevice);
hum_perrh = HYGRO_getHumidity(&myDevice);
sprintf (debugStr, "Temp is %f Humidity is %f\r\n\n", temp_degc, hum_perrh );
print ( debugStr );
NAV_GetData(&nav);
sprintf (debugStr, "X is %f Y is %f Z is %f\r\n\n", nav.acclData.X, nav.acclData.Y, nav.acclData.Z );

print ( debugStr );
sample = FALSE;
}

Copyright 2020 Adiuvo Engineering & Training, Ltd. 82



Lab 3: Completing a Simple Application

Step 38 — The expected output should produce something like below

2@ COM26 - PuTTY — O X




Lab 3: Completing a Simple Application

Step 39 — Now, let’s test our application on the
hardware.

Use a file browser navigate to
V:\hardware\m1 for_arty s7\ml for_arty s7.

You will see a file named bram_s7.elf and
bram_s7.hex. These should have today’s time
stamp as you just generated them.

0OS (Vi)

> hardware

> m1_for_arty_s7 m1_for_arty_s7

Name

m1_for_arty_s7.cache
m1_for_arty_s7.hw
m1_for_arty_s7.runs
m1_for_arty_s7.sdk

m1_for_arty s7.sim

bram_s7.elf

bram_s7.hex

ml.mmi

m1_for_arty_s7.xpr
m1_for_arty_s7_reference.bit
m1_for_arty_s7_reference.mcs

make_mmi_file.tcl

[%] make_prog_files.bat

make_prog_files.tcl



Lab 3: Completing a Simple Application

Step 40 — Double click on make_prog_files.bat

This will create the bit file needed with the Cortex-M1 and application we just created to download
into the Arty S7-50 board.

Step 41 — Power off the Arty S7 board and connect the PmodNAV to PmodA and PmodHYGRO to
PmodB. |

QC.0K
13 :
5 (3 8

5808 saaage

=
W
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Lab 3: Completing a Simple Application

Step 42 — Power on the Arty Board and In Vivado open the Hardware Manager.

¢ m1_for_arty s7 - V/hardware, _for_arty_s7/m1_fo - o X
Elle Edit Flow Tools Repots Window Layout View Help wiite_bitstream Complete
= & F » K & X ¢ < Default Layout v

Add Sources Design Project Summary
Language Templates Q = 13 &
Settings Eat
T IP Catalog
Extemal Interfaces Project name: m1_for_arty_s7
v IP INTEGRATOR Interface Connections Project location: V/hardware/m1_for_arty_s7/m1_for_arty_s7
Ports duct family 8 7
Create Block Design t Product famil Spartan
Nets Project part 0 24-1
Open Block Design
pen - @d_bram_ci_0 Top module name _for_arty_s7_)
Generate Block Design ad_gpio_0 Target language: og
Simulator language Mixe
v SIMULATION Source File Properties
Run Simulation o
Board Part
v RTLANALYSIS Display name Arty S7-50
> Open Elaborated Design Board part name: digilentinc.com:arty-s7-50:part0:1.0
Connectors. No connections
v SYNTHESIS 2 ™ o0 adal019.2 ad s
P Run Synthesis Tel Console
> Open Synthesized Design QT 2 N1 B E B
-

<

IMPLEMENTATION
P Runimplementation

> Open implemented Design

v PROGRAM AND DEBUG

Specity and/or create source files to add to the project

or_arty_s7_wrapper.hdf
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Step 43 — Once Hardware Manager is open, select Open Target and auto connect. This will open
the JTAG link with the target board.

Lab 3: Completing a Simple Application

=, > E o T

Flow Navigator E 3R DS HARDWARE MANAGER - uncogas
© No hardware targe @
Add Sources
es Hardware

IIIIIIIIIIII



Step 44 — This will connect to the Arty S7-50 so that we can program it. Before we do this we
should open a terminal program (such as terra term or PuTTY) so that we can see the output from

the serial link.

Lab 3: Completing a Simple Application

Set it for 115200, 1 Start, 1 Stop no Parity.



Lab 3: Completing a Simple Application

Step 45 — To program the FPGA in Hardware Manager we need to select the correct bit file. Select
Program Device.

¢ m1_for_arty 7 - [Vi/hardware/m1_for_arty s7/m1_for arty s7/m1_for_arty s7xpr] - Vivado 2018.2
File Edt Flow Tools Repots Window Layout View Help
&, - b, W & Dashboard ~ {
Flow Navigator =3 B HARDWARE MANAGER -
el

Add Sources
Language Templates

T 1P Catalog

v IP INTEGRATOR

Create Block Desig

Generate Block Design

v SIMULATION

Run Simulation

v RTLANALYSIS

> Open Elaborated Design

ized Design

localhosthdlinx tciDigilent/210352A5C 1684
© There are no debug c fo e

Hardware
Q¢ o
Name Status
¥ localhost Connected
a ctDigilent’210352A6C1..  Open
0.0 Not programm
XADC
Properties
o

Tcl Console

] X
write_bitstream Complete /'

Default Layout




Lab 3: Completing a Simple Application

Step 46 — When the dialog appears, select the file
V:./hardware/m1 for_arty s7/ml1 for_arty s7/m1 for_arty s7.bit

¢ Program Device

Select a bitstream programming file and download it to your hardware device. You can optionally
select a debug probes file that corresponds to the debug cores contained in the bitstream /
programming file

Bitstream file: V.lhardware/m1_for_arty_s7/m1_for_arty_s7/m1_for_arty_s7.bit l -

Debug probes file:

v Enable end of startup check

\2 Program Cancel

Step 47 — Check the output in your terminal.

Congratulations! You have finished Lab 3 and completed your simple application.



